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INTRODUCTION	
  
 

 
Airborne lidar (laser scanning) data was collected using NASA’s Land Vegetation and Ice 
Sensor (LVIS) in Gabon in February and March 2016. The data have been processed and are 
available on the internet for download.  Please visit the LVIS web page to download the data and 
get more information: 
http://lvis.gsfc.nasa.gov/Gabon_2016.html 
 
 
These set of exercises represent an introduction to locating and downloading LVIS data files 
from the LVIS website, to understanding the contents of the data files, and to open and view the 
elevation and height data in a freely available GIS software package.  
 
For help and more information, please contact: 

Michelle	
  Hofton,	
  University	
  of	
  Maryland	
  College	
  Park,	
  MD,	
  USA.	
  mhofton@umd.edu	
  
Helen	
  Cornejo	
  (class	
  instructor),	
  NASA	
  Goddard	
  Space	
  Flight	
  Center,	
  Greenbelt,	
  MD,	
  USA.	
  

Helen.Cornejo@nasa.gov	
  
Bryan	
  Blair,	
  NASA	
  Goddard	
  Space	
  Flight	
  Center,	
  Greenbelt,	
  MD,	
  USA.	
  

Bryan.Blair@nasa.gov	
  

	
  
Background 
 
The LVIS system was mounted on the NASA Langley King Air B200 (Figure A) and measured 
the earth through a hatch in the bottom of the airplane.  

 
Figure A: NASA Langley King Air in Gabon 
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The LVIS system sends laser beams to the earth, which are reflected by all objects in the laser 
path and the returned waveform is recorded by the LVIS system. Vertical profiles of the 
vegetation can be obtained as canopy gaps allow for the laser to penetrate to the forest floor and 
thus reflect energy at all different layers of the vegetation. A vertical profile is returned, 
providing all information on the vertical vegetation profile (Figure B). The diameter of the laser 
footprint that reaches the ground is approximately 25 meters, meaning that information on the 
vegetation within that 25-meter footprint is captured in the waveform signal.  
 

	
    
Figure B (left): example of lidar waveform signal and vegetation sample  

 
Figure C (right): visualization of LVIS spatial sampling pattern 

 
LVIS has a swath width of approximately 2 km. A swath consists of multiple, sometimes 
overlapping footprints typically 20 m in diameter and separated by 10 m along and across track 
(in Gabon). The laser scans from left to right, then right to left, perpendicular to the direction of 
flight as the plane flies along predefined fight paths. The footprint pattern on the ground will be 
dense, approximately equi-spaced (Figure C).  
 
 
Suggested background reading: 
 
Blair, J. and Rabine, D. and Hofton, M., The Laser Vegetation Imaging Sensor: a medium-altitude, 
digitisation-only, airborne laser altimeter for mapping vegetation and topography, ISPRS Journal of 
Photogrammetry and Remote Sensing,  54  115—122, DOI: 10.1016/S0924-2716(99)00002-7,  1999	
  
 
Hofton, M. and Blair, J. and Minster, J. and Ridgway, J. and Williams, N. and Bufton, J. and Rabine, D.  
An airborne scanning laser altimetry survey of Long Valley, California, International Journal of Remote 
Sensing  21, DOI: 10.1080/0143116005003054 , 2000 
	
  
Dubayah, R. O. and Sheldon, S. L. and Clark, D. B. and Hofton, M. A. and Blair, J. B. and Hurtt, G. C. 
and Chazdon, R. L, Estimation of tropical forest height and biomass dynamics using lidar remote sensing 
at La Selva, Costa Rica, Journal of Geophysical Research-Biogeosciences,  115,  DOI: 
10.1029/2009JG000933, 2010 
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Software needed to complete this course 
 
The software that we use to visualize LVIS Level 2 data is QGIS, a free open source GIS 
software package. For more details, please visit http://www.qgis.org 
 
To download a copy of the software, please visit: 
http://www.qgis.org/en/site/forusers/download.html 
and install the current version of the software. 
In this module, we have used version 2.18 for the Mac. 
 
We have installed GDAL also as part of QGIS; this should come with the download bundle.  
 
Modules to look at LVIS Level 1B waveform data require Python. Python typically comes 
preinstalled on a Mac and you only need install the Python package h5py (http://www.h5py.org/) 
for HDF format files. Please talk to your system administrator.  
(A suggested way to install this module is to use a Package management system such as PIP: 
download this from https://bootstrap.pypa.io/get-pip.py. At a terminal prompt, type 	
  
sudo python get-pip.py 
sudo pip install h5py) 
 
 
LVIS Flights in Gabon, 2016 
 
Seven LVIS flights were flown in Gabon, each targeted to a different interest area. Trajectories 
for each flight are available online. You can download these trajectories and view them in 
Google Earth or other software. You can also use the LVIS web site: 
 

! Navigate to the website: http://lvis.gsfc.nasa.gov/Gabon2016Map.html  
 
Underneath the map you can tick the boxes to find out where data was collected on the different 
collection dates. Navigate to Gabon on the map and explore where data was collected. Today we 
are going to use the data that was collected on March 8th, 2016. This was a flight that covered 
Pongara and Mondah areas. 
 
You can use this map to identify which flight days may contain data that you are interested in. 
Make a note of the day, as you will need this to help download a data file later. 
 
 
Data Files 
 
For LVIS there are two different datasets available:  Level 1B and Level 2. The level indicates 
the amount of processing the data has undergone before it was published. Level 1B data contains 
georeferenced lidar return waveforms. The Level 2 data contains georeferencing information for 
different reflecting surfaces within the laser footprint, the locations of which have been derived 
from the Level 1B waveform. The Level 2 data is similar to a ‘point cloud’ file that you would 
receive from a commercial lidar instrument. Typical parameters are ground elevation, canopy top 
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elevation, canopy height and several other ‘height metrics’ which will be explained later in 
detail.  
 
We will start exploring the Level 2 data first before looking at the more complicated waveform 
data.  
 

! Navigate to the website: http://lvis.gsfc.nasa.gov/Gabon_2016.html  
 
On this internet page you can download all the data in data chunks. The data is organized by 
target area. (To understand where the different areas are, please use the map showing where and 
when data were collected at http://lvis.gsfc.nasa.gov/Gabon2016Map.html) 
 
Today we are going to use the data that was collected on March 8th, 2016. 
 

! Find the Level2 datasets that were collected on March 8th, covering Mondah National 
Park (don’t download them) 

 
As you can see, there are 18 .TXT files for this flight day. Every file is approximately 120 MB. 
In order to speed up the class today, we have prepared a subset of the data for viewing and 
analysis. This should be downloaded to your computer already.  
 

! Find the file named LVIS_Mondah_level2.TXT on your computer 
! Open the file in a text editor 

 
As this is a simple .txt file, we can open it in a text editor and explore what the data looks like. 
Notice that the file has 12 lines of comments and 1 header line before the actual data begins. The 
header line gives information about the column names. The column names are all abbreviations. 
More information about the abbreviations and how to interpret them can be found on the LVIS 
website: 
  

! Navigate to the document 
http://lvis.gsfc.nasa.gov/data_sets/2016_gabon/LVIS_GabonAfriSAR_data_release.pdf  

 
Page 3 contains the abbreviations of the column names in the Level 2 dataset we are currently 
looking at.  
 

! Familiarize yourself with the column names and answer the following questions  
 

1. Where can we find information on the location of each laser footprint?  
2. In which column is information about the ground elevation stored?  
3. Which column contains information on the canopy top elevation?  
4. Which column contains information on the canopy height? 
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TUTORIAL	
  
Displaying	
  LVIS	
  Data	
  in	
  QGIS 

	
  
	
  
	
  
This	
  exercise	
  will	
  work	
  with	
  any	
  of	
  the	
  Level	
  2	
  TXT	
  files	
  downloaded	
  directly	
  from	
  the	
  LVIS	
  
website:	
  
	
  
http://lvis.gsfc.nasa.gov/Gabon_2016.html 
	
  
Each	
  file	
  is	
  approximately	
  120	
  MB,	
  so	
  in	
  order	
  to	
  speed	
  things	
  up,	
  we	
  have	
  prepared	
  a	
  
subset	
  of	
  data	
  for	
  viewing	
  and	
  analysis.	
  This	
  should	
  be	
  downloaded	
  to	
  your	
  computer	
  
already:	
  LVIS_mondah_level2.TXT. This dataset was collected on March 8th, 2016 over 
Mondah National Park.	
  

Open	
  up	
  QGIS	
  by	
  clicking	
  on	
  this	
  icon:	
   	
  
	
  
	
  
STEP	
  1:	
  Open	
  a	
  Level	
  2	
  file	
  in	
  QGIS	
  
	
  
We	
  are	
  going	
  to	
  read	
  in LVIS_mondah_level2.TXT	
  as	
  a	
  Delimited	
  Text	
  Layer.	
  You	
  can	
  do	
  
this	
  in	
  2	
  different	
  ways:	
  

1.A.	
  Click	
  on	
  this	
  symbol	
  in	
  the	
  vertical	
  tool	
  bar	
  to	
  the	
  left:	
   	
  
1.B.	
  OR	
  select	
  in	
  the	
  upper	
  tool	
  bar:	
  Layer	
  -­‐>	
  Add	
  Layer	
  -­‐>	
  Add	
  Delimited	
  Text	
  Layer	
  

	
  
Figure	
  1:	
  Screenshot	
  of	
  first	
  QGIS	
  GUI	
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STEP	
  2:	
  Read	
  in	
  the	
  Level2	
  file	
  with	
  the	
  correct	
  options	
  
	
  
This	
  screen	
  should	
  pop	
  up:	
  
	
  

Figure	
  2: Screenshot of the data ingest GUI in QGIS	
  

	
  
	
  
2.1.	
  Browse	
  to	
  your	
  file	
  LVIS_mondah_level2.TXT 
 
You	
  will	
  see	
  the	
  contents	
  of	
  the	
  text	
  file	
  appear	
  in	
  the	
  window.	
  We	
  need	
  to	
  select	
  some	
  
options	
  to	
  read	
  in	
  this	
  data	
  correctly:	
  
	
  
2.2.	
  Click	
  on	
  the	
  button	
  Custom	
  Delimiters	
  
	
  
Several	
  more	
  options	
  will	
  appear	
  as	
  in	
  Figure	
  3:	
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Figure	
  3: Adjusting the options to read in LVIS Level 2 data	
  

	
  
2.3.	
  Click	
  on	
  Space	
  
	
  
2.4.	
  In	
  the	
  Other	
  Delimiters	
  box	
  enter	
  the	
  symbol	
  #	
  that	
  LVIS	
  uses	
  to	
  denote	
  lines	
  of	
  text	
  
	
  
2.5.	
  In	
  the	
  Number	
  of	
  header	
  lines	
  to	
  discard	
  enter	
  12	
  
	
  
2.6.	
  Click	
  on	
  First	
  record	
  has	
  field	
  names	
  
	
  
2.7.	
  Click	
  on	
  Discard	
  empty	
  fields	
  
	
  
Now	
  QGIS	
  is	
  reading	
  in	
  the	
  file	
  correctly.	
  Next	
  step	
  is	
  to	
  select	
  which	
  variables	
  we	
  want	
  to	
  
plot.	
  
	
  
2.8.	
  Click	
  on	
  Point	
  coordinates	
  
	
  
2.9.	
  Select	
  GLON	
  for	
  the	
  X	
  field	
  and	
  GLAT	
  for	
  the	
  Y	
  field	
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2.10.	
  Click	
  OK	
  
	
  
2.11.	
  Select	
  the	
  Reference	
  System.	
  A	
  box	
  labeled	
  Coordinate	
  Reference	
  System	
  Selector	
  
should	
  pop	
  up	
  (Figure	
  4).	
  LVIS	
  data	
  is	
  referenced	
  to	
  the	
  ellipsoid	
  WGS	
  84,	
  so	
  select	
  WGS	
  84	
  
and	
  click	
  OK	
  
	
  
	
  

Figure	
  4: Screenshot of the reference frame selection 
	
  

	
  

Be patient. Even though this is a spatial subset, it is still quite a big file. Points for each single 
laser return are now drawn on your screen. The display will need adjusting for better viewing. 

 

STEP	
  3:	
  A	
  First	
  Look	
  at	
  LVIS	
  Data	
  

For now you can only see the location of the shots on the ground. 

Q1. Can you distinguish a plane swath and the across-track scanning of the laser? 

Q2. How many swaths can you see in total? Do they overlap?  

 

In Figure 5 we have included an image of the swaths with individual colors to make the 
distinction easier. You will learn how to do this later in the lesson.	
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Figure	
  5	
  

 

	
  
 

Try zooming in on the data. Can you distinguish the individual points? To zoom in and out, you 
can use these icons or use your mouse 

 

If you want to restore your map to its original state, click on the last magnifier glass with the 3 
outwards-pointing arrows. 

QGIS allows us to measure the distance between two footprints and more. Look for the little 
ruler icon at the top right of your screen. You may have to click on an arrow to reach it. 

	
  

This brings up a tool that will measure any distance you can measure on the map just by clicking 
two separate locations. 
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Figure	
  6	
  

 
 

       Q3. What is the approximate distance between two consecutive footprints? 

       Q4. What is the approximate width of an LVIS swath? 

       Q5. What is the approximate area of Mondah that we are studying? You can calculate it by 
measuring the sides, or you can use the Measure Area option from the ruler icon. 

 

STEP	
  4:	
  Visualizing	
  LVIS	
  Level	
  2	
  Data	
  in	
  QGIS	
  

If you do not have the Layers Panel on your screen, find any one of the light gray dots in the 
toolbars (Figure 7). When you hover your cursor over it, it should become a white cross. Right-
click, and select Layers Panel. A box should appear with the available layer names. You should 
just have the one layer you have been working on: LVIS_Mondah_level2. 
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Figure	
  7:	
  Where	
  to	
  find	
  the	
  extra	
  options 

 
 
 
We need to modify the properties of this layer.  
 
4.1. Double-click on the layer name LVIS_Mondah_level2 and a box titled Layer Properties will 
appear (Figure 8). Alternately, you can left-click on the layer name, and select Properties in the 
pop-up menu. 
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Figure	
  8:	
  Screenshot	
  of	
  the	
  Layer	
  Properties	
  GUI 

 
 
4.2 In the left column click on Style (2nd from top). 
 
4.3 In the top drop-down menu, select Graduated. This means that we want a color scale, with 
different colors representing different values. 
 
4.4 Next, click on the Column drop-down menu. This shows you all the variables available in the 
file. Choose ZG. This is the elevation of the ground detected by LVIS. 
 
4.5 Click on the Symbol box where it shows the current marker. We are going to change it. A 
Symbol Selector panel pops up (Figure 9) 
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Figure	
  9:	
  Screenshot	
  of	
  the	
  Symbol	
  Selector	
  GUI

 
4.6. Click on the Simple marker in the 1st box 
 
4.7. In the Symbol layer type, select the 3rd line down, Size, and change the value from 2 to 1 

mm. This will make the shots a little clearer on your screen. 
 
4.8. On the 4th line down, Outline Style, click on the drop-down menu and select No Pen instead 

of Solid Line. This removes the black line around your symbol. (Alternately you could select 
the color of outline, and set it to Transparent.) 

 
4.9. Click OK to get back to the Layer Properties panel 
 
4.10. Click on Color Ramp and select a color scale that you think will be a good representation 

of the ground 
 
4.11. Under Mode select Quantile (Equal Count) 
 
4.12. On the right, change the number of Classes to 20 
 
4.13. Click on Apply to see your changes take place on the screen. When you are happy with 

your choice, click on OK 
 
4.14. In the Layers Panel, click the symbol to the left of your layer’s name 

(LVIS_Mondah_level2). This will show the legend.  
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Q3. Which part of the scene has the lowest elevation? The highest? 
 
Q4. Describe the landscape based on the elevation of the ground. What kind of features do 

you recognize? 
 

Figure	
  10:	
  LVIS	
  ground	
  data	
  colored	
  by	
  elevation	
  
	
  

 
 
 
 
STEP	
  5:	
  Visualizing	
  the	
  Canopy	
  Height	
  

 
Now that we know how to look at the ground elevation, we can use the same method to look at 
canopy height (RH100).  
 
5.1. Navigate back to the Layer Properties panel and to Style 
 
5.2. For Column, select RH100 as our variable to map 
 
5.3. Select a different color ramp, one that you think will suit the maximum vegetation height 
 
5.4. For Mode, select Equal Interval 
 
5.5. For Classes, select 5 
 
5.6. Click on the arrow to the left of the words Layer Rendering: this will open up a few more 
options (Figure 11) 
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Figure	
  11:	
  Where	
  to	
  find	
  the	
  Layer	
  Rendering	
  options 

 
 
 
5.7. Click on Control feature rendering order; this will activate a small icon to the right 
 
5.8. Click on that icon: a box labeled Define order will pop up (Figure 12) 
 

Figure	
  12	
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5.9. Under Expression, select RH100 
 
5.10. Under NULLs handling select NULLs first 
 
5.11. Click OK 
 
This controls the order in which the symbols are plotted. This is useful if the symbols overlap. 
Here we are plotting them in ascending order, that is, the highest locations are plotted last, and 
are therefore more visible. 
 

Figure	
  13:	
  LVIS	
  canopy	
  height	
  colored	
  by	
  elevation	
  
	
  

	
  
 
 
 Q5. Where are the highest trees? How high is the highest tree, according to the maximum 
height measured for all footprints? 
 
We can mark on the map where the highest trees are: 
 
5.12. In the Layers Panel, double-click on the highest elevation band (in this case 52-65 m) 
 
5.13. In the window that pops up, click on Simple Marker. Scroll down and select a color for the 
Fill and increase the Size. Click OK. The highest trees will now be marked in a different color. 
Try this with different elevation bands and different symbol colors 
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Figure	
  14:	
  Highest	
  and	
  lowest	
  values	
  of	
  RH100	
  
	
  

	
  
 
 
 Q6. Where is the lowest vegetation height? Do you recognize these features? 
 
 Q7. Make a map of the variable RH50. RH50 is the height above the ground where 50% 
of the energy was reflected. RH50 can be used as an estimator of above-ground biomass in a 
forest. 
 
 Q8. Try coloring it by TIME. You should get something similar to the 2nd plot in Fig. 5	
  

	
  

STEP	
  6:	
  Viewing	
  Level	
  2	
  Data	
  in	
  Profile	
  

Each point has several values associated with it, for example ZG and RH100. We have made one 
map for each value. Another way to look at the data is to see ZG and RH100 simultaneously. 
When you stand on the ground and look at a forest, you can see both the ground and the 
vegetation at the same time. We are going to do that here. 

 

6.1. Select an area that you would like to look at in profile. To do this, click on this icon, which 
is on the upper toolbar to the right:  
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This allows you to Select Features by area or single click. In this case we are going to select a 
small area on the map. The profile program plots the data by longitude, so it is best to select a 
thin horizontal area as in Figure 15: 

Figure	
  15:	
  A	
  small	
  area	
  selected	
  on	
  the	
  map	
  
	
  

	
  
 

In this example, we have chosen an area that has both tall trees and a portion of the road. 

If you are not happy with your selection, simply click on the Deselect Features from all Layers 
icon and start over: 

  

6.2. Bring up the Layers Panel and right click on your layer, LVIS_Mondah_level2. Click on 
Open Attribute Table. This opens up a table with all the points and all the values associated with 
them. We only want to look at the area we selected. In the bottom left-hand corner, click on the 
drop-down menu, and scroll to Show Selected Features (Figure 16): 

Figure	
  16:	
  The	
  Attribute	
  Table	
  

	
  
	
  

6.3. To look at these data in profile, we are going to use a Python program which we have 
downloaded onto your computer: py_L2plots.py. To run this program, bring up the Python 
console by clicking on this icon that you will find to the right of the 2nd horizontal toolbar: 
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This will bring up a window you can type in. Enter these commands, replacing 
‘/My/working/directory’ with the path to the directory where you have the py_L2plots.py  
program: 

>>> import os 
>>> os.chdir(‘/My/working/directory’) 
>>> execfile(‘py_L2plots.py’) 
 

The program notes how many points it processed, and plots them on a pop-up screen. To get a 
better look at the data, use the rectangular zoom tool. 

Figure	
  14	
  

	
  
The five colors represent the following variables: 

ZG: elevation of the ground 

RH25: height above the ground where 25% of the energy is reflected 

RH50: height above the ground where 50% of the energy is reflected 

RH75: height above the ground where 75% of the energy is reflected 

ZT: elevation of the tree tops 

 Q9. Where is the ground? The top of the trees? Can you see the road? 

 Q10. How would you calculate the height of the trees based on these variables? What 
other Level 2 variable represents the height of the trees? 
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STEP	
  7:	
  Looking	
  at	
  the	
  Waveforms	
  

Each point has a waveform associated with it. These waveforms are available in the LVIS Level 
1B H5 files. We have preloaded the matching Mondah H5 file on your computers: 
LVIS_Mondah_level1b.h5. We can select a point on the map and look up its waveform. 

7.1. Select Features by area or single click: this time we are going to select a single point. Move 
the cursor to a point that you’re interested in and double-click. The selected point should turn 
yellow. Below we selected a tall tree near the road. 

Figure	
  15	
  
	
  

	
  
 

7.2. Call up the Attribute Table (by right-clicking on the Layer in the Layer Panel) and scroll to 
Show Selected Features. There should be only one point in the table. Each point is uniquely 
identified by its LFID and shotnumber. Note the shotnumber of the point you selected. In our 
case it is shotnumber 10964985. 

7.3 You should have a Python program named py_waveplot.py pre-loaded on your computer. 
Navigate to that directory and type this at the command line: 

python py_waveplot.py LVIS_Mondah_level1b.h5 LVIS_Mondah_level2.TXT 

The program will ask you to enter a shot number; enter the one you wish to look at: 

Please enter shot number: 10964985 

A window should pop up with to the left, the return waveform. To the right is the same 
waveform, zoomed in on the features, and with the values of ZG, RH25, RH50, RH75, and ZT 
drawn in.  
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Figure	
  16:	
  Vegetation	
  waveform	
  

	
  
	
  

Q10.	
  Which	
  part	
  of	
  the	
  waveform	
  detects	
  the	
  ground?	
  What	
  is	
  the	
  approximate	
  
elevation	
  of	
  the	
  ground?	
  What	
  is	
  the	
  approximate	
  height	
  of	
  the	
  tallest	
  tree	
  in	
  this	
  footprint?	
  

	
  
7.4. Select a point on the road. This waveform will be much simpler than the waveform returned 
from the forest. Note: the RH values aren’t really meaningful when it comes to bare surfaces 
 

Figure	
  17:	
  Waveform	
  over	
  the	
  road	
  

	
  
	
  
Q11.	
  Why	
  is	
  this	
  waveform	
  so	
  different	
  from	
  the	
  previous	
  one?	
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Figure	
  18:	
  Photograph	
  of	
  the	
  area	
  where	
  these	
  waveforms	
  were	
  collected	
  
	
  

	
  
	
  

	
  
	
  
	
  
STEP	
  8:	
  Rasters	
  

In our previous maps when you zoom in, you see individual points. You are looking at a colored 
point cloud, not at a continuous map. We can create a raster from the points, in other words, a 
regular grid with continuous data. To do so we first need to create a Shapefile from the TXT file 
that we have loaded now. 
 
8.1. Right-click on your layer LVIS_Mondah_level2 in the Layers Panel  
 
8.2. Scroll down and click on Save As… 
 
8.3. Select the Format of the saved file: ESRI Shapefile 
 
8.4. Click on Browse and choose what to name the saved file and where to save it. It can have 
the same root name as the main file. QGIS will automatically append the extension .shp, for 
example like this: LVIS_Mondah_level2.shp 
 
8.5. Make sure that your Coordinate Reference System (CRS) is still set to EPSG:4326, WGS 
84. This specifies the georeferencing, in our case WGS84 with latitude/longitude coordinates. 
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Figure	
  19:	
  Saving	
  the	
  Vector	
  Layer	
  as	
  a	
  Shapefile	
  

	
  
 
8.6. Click on OK. Be patient. When it has finished, a new layer will have been created and will 
appear in your Layers Panel. The little symbol to the left of it will be one large point, rather than 
the three small points indicating the original layer. You can right-click on it and bring up the 
Attribute Table to verify that it is the same data. 
 
8.7. From this shapefile we can create a raster. We know that the total area of the data we are 
studying is about 3400 x 3400 m. We also know that the distance between two LVIS footprints is 
approximately 10 m. We want several points averaged into one cell, so a good sized-cell would 
be 25 m. This means we will have 3400 / 25 = 136 cells in each direction. Let’s round it up to 
150. 
 
In the top menu, click on Raster -> Conversion -> Rasterize (Vector to Raster)… 
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Figure	
  19	
  

	
  
	
  
8.8. The input file will be the shapefile you just created. In the Attribute field choose ZG (the 
ground elevation) 
 
8.9. Name the output file LVIS_raster_zg. QGIS will automatically append a TIFF extension 
(.tif) to the file name: LVIS_raster_zg.tif. 
 
8.10. Select Raster size in pixels and input the numbers we estimated above: 150 x 150 
 
8.11. Click on OK. Two more windows will pop up while QGIS is doing the calculations. Click 
OK in these two windows then click Close on the original Rasterize window (clicking OK will 
just make the program do the calculations again). 
 
You should now have a black-and-white display of regularly gridded data. You can adjust the 
colors if you’d like (Figure 20) 
 
 
 Q12. How would you adjust the colors? Hint: call up the Layer Properties and adjust the 
Band Rendering from Singleband gray to Singleband pseudocolor. Proceed as before. 
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Figure	
  20:	
  A	
  raster	
  of	
  the	
  ground	
  elevation	
  

	
  

	
  
	
  
	
  

 
STEP	
  9:	
  Profiles	
  and	
  PlugIns	
  
 
We can look at this map from above, or we can draw a transect across it and look at the elevation 
profile. To do this we need to install our first plugin: 
 
9.1. From the top menu, click on Plugins -> Manage and Install Plugins… 
 
9.2. In the Plugins window that pops up, either type Profile tool in the search bar, or scroll down 
to it. Click on it 
 
9.3. Click on Install plugin and then when it has finished, click on Close 
 
You should see a new icon added to your toolbar: 

 
 
9.4. Click on this new profile tool button: a window should pop up 
 
9.5. Click anywhere on the map. Your cursor should now be dragging a red line. Once you are 
satisfied with your line, double-click. The line in red on the map will be shown in profile in the 
lower window like this: 
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Figure	
  21:	
  Viewing	
  the	
  elevation	
  profile	
  of	
  a	
  transect	
  

	
  
	
  

9.6. You can link the position of the cursor on the map to the position on the profile by clicking 
Settings and clicking on Link mouse position on graph with canvas	
  

	
  
Figure	
  22:	
  Linking	
  the	
  mouse	
  position	
  

	
  
	
  

	
  
	
  

 
9.7. You can also look at a multi-segment profile by clicking once for each end of segment and 
double-clicking when you are done: 
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Figure	
  23:	
  Profile	
  of	
  the	
  river	
  

	
  
 
 
STEP	
  10:	
  Downloading	
  Additional	
  GIS	
  Data	
  
 
There are many GIS datasets online that you can download for free. To start off with, the LVIS 
website has Shapefiles for all our flights. For those in Gabon, go to: 
 
https://lvis.gsfc.nasa.gov/Gabon2016Map.html 
 
It would be interesting to download the flight path for March 8th, 2016 and see it overlaid on our 
Mondah data (see Figure 24). On the LVIS website, click on the box to the left to visualize the 
flight on the map, and click on the [shp] to the very right of that same line to download the data. 
Once you have downloaded it, you will need to unzip it: 
 
unzip traj57455_LVIS_SHP.zip 
 
You now will have a file named traj57455_LVIS.shp in your directory. Load this as a vector 
layer. Either click on the vector layer button to the left and at the top of the window: 
 

 
 
Or click through from the main menu:  
 
Layer -> Create Layer -> New Shapefile Layer… 
 
You should see something like in Figure 25. We have adjusted the symbols to make the flight 
lines more visible. You can see the 5 straight lines that represent the path of the flight as LVIS 
scans and collects data. These are 2 more flight lines visible. They are curved, and represent 
turns made by the plane to switch from line to line. We often take out the data gathered during 
the turns since the high roll of the plane impacts the data negatively. 
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Figure	
  24:	
  Downloading	
  the	
  Flight	
  Paths	
  

	
  
Figure	
  25:	
  Flight	
  Path	
  drawn	
  over	
  the	
  collected	
  LVIS	
  data
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There are also several interesting data sets here:  
 
http://gab.forest-atlas.org/ 
 
All of them can be downloaded directly from the main website and loaded into QGIS as shown 
above. 
 

Figure	
  26:	
  Interactive	
  Forest	
  Atlas	
  of	
  Gabon	
  
	
  

	
  
 
 
Google Earth is also interesting. Instead of downloading the Shapefile data for a flight, download 
the KMZ file. These can be uploaded in to Google Earth. Interesting note: the imagery used here 
by Google Earth is dated February 2016, just a month before LVIS gathered the data we have 
been working with. You can clearly see the vegetation features detected by LVIS. LVIS also 
gives us the ground elevation beneath the canopy, which is not visible here.	
  
 
 
Google Earth can be downloaded here for free: 
 
https://www.google.com/earth/ 
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Figure	
  27:	
  Flight	
  Path	
  seen	
  in	
  Google	
  Earth	
  

	
  


